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Lab work objective: Mastering the basic commands and principles in
creating three-dimensional models using simple
examples, steps in the modeling process and
acquisition  of  practical skills  for their

implementation.

1. GOALS

Almost all machinery parts are now designed with the obligatory
application of the achievements of modern computer technologies,
including such of them as 3D graphics. Technology such as 3D
modeling makes it possible to create images of almost any part in such
a way that they are as realistic as possible. 3D modeling makes it
possible to visualize those parts that do not yet exist in reality and that
are still in development.

In order to visually create three-dimensional models of various
parts, based on which various mathematical calculations are made and
a visual assessment is made, specialized software packages are used.
Their creators were able to ensure that any change in at least one of
the three coordinates of the 3D model would automatically lead to
corresponding changes in the rest of the design and engineering
documentation.

As practice shows, now three-dimensional modeling is
successfully used in many areas of modern technology, but it gives the
best results when the layout of various plant equipment is designed,

high-complexity drawings are created, and various complex structures



are designed. In addition, 3D modeling is almost indispensable when
it is required to ensure the most accurate (that is, with minimal gaps)
mating of various parts and components, and it is also necessary to
ensure that the most stringent technical requirements are met.

Modern computer technologies have at their disposal such tools
for three-dimensional modeling, which allow simulating the
functioning of robots and generating tool paths. Thanks to this, 3D
modeling has already become one of the integral parts of modern
production.

It should be noted that the overwhelming majority of modern
three-dimensional modeling systems have tools for automatic analysis
of such physical characteristics as moments of inertia and weight, they
have a variety of tools that allow solving geometric problems that
arise when creating complex mates, as well as with various
interpretations.

3D modeling is especially useful in cases where you need to
repeatedly edit a three-dimensional object at almost all stages of its
design. The fact is that in three-dimensional modeling systems there is
an automatic connection between those data that have different
geometric types of images.

Three-dimensional models are divided into three types according
to their functional purpose: wireframe, surface and solid.

The simplest of these are wireframes, which are essentially sets
of lines and arc segments interconnected in three-dimensional space.
There is no relationship between them, they describe only the edges of

objects and their use is very limited.



Surface models are sets of surfaces that are connected in space in
such a way that they form a three-dimensional object. Unlike
wireframes, they carry information about the silhouette and contours
of surfaces. Surface models are widely used in computerized
manufacturing systems.

Solid models are the most advanced, since they carry information
not only about edges and planes, but also about the internal volume.
They can be used not only for visualization, but also for carrying out

various calculations.

2. THEORETICAL INFORMATION

T-FLEX CAD system allows various approaches to creating a 3D
model. The main method is creating most of constructions directly in the
3D window. In another approach, a 3D model is created based on already
prepared 2D drawings or auxiliary 2D constructions. This construction
may further be used for generating drawings by projecting the model in all
necessary views and making cuts and sections. These 2D objects can
further be furnished with necessary dimensions and other drawing
attributes.

2.1. Main Approach to 3D Model Creation

This approach makes possible creating a three-dimensional model
without using the 2D window. The diagram below shows a sample part
that we will be modeling. We will create the three-dimensional model first,

and then automatically generate views and a section.



The model file IS located in the folder

“...\Examples\Documentation examples. Introductory
course\Detail with drawing detailing”.

The model creation will be done in several steps. First, one has to
create initial auxiliary elements. Based on those, you will be able to create
a first draft of the considered part — without the holes and chamfer. To do
this, use the “Rotation” operation. At the next step, add six holes in the
part’s body. Holes can be created by different means. We will discuss
several methods here to give you a more complete idea about 3D model
creation methods. Then, to get the final version of the part, you will just
need to apply a chamfer via the “Blend” command.

2.2. Creating Auxiliary Elements
Let’s start from scratch. Create new document.

To begin modeling, one can use an appropriate prototype file
among available in the T-FLEX CAD system (File > New 3D
Model).

You have just created a new document that already has three
standard workplanes — Front, Right and Bottom. You can see that the 3D
window with these elements opens automatically within the system
window.



For convenience of modeling in 3D window, spinning,
panning and zooming of the scene view are available at all times,
even when commands are active. Note: the view manipulations
while in certain commands require a specific option to be set. These
commands will be described below. To spin the scene press and

hold & and move the cursor as desired. One can also use the two
arrow key pairs and the pair <Page Up> and <Page Down> for
spinning around the three respective axes. Zooming can be done at
any moment by scrolling the mouse wheel button (as in
IntelliMouse design) or via the provided commands on the “View”
toolbar located along the right border of the window. Panning and

, . : N
zooming of the view can also be controlled via <Ctrl>+ .7 and

<shift>+ ) combinations respectively.

As we move the cursor close to a workplane, the latter gets
highlighted. T-FLEX CAD provides pre-highlighting on cursor over for all
elements in the 3D window depending on the selection filter settings.

The selection filter icons are located on the system toolbar. To pick

: : i
an element among the icons, simply press ..
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Let’s select the “Right” workplane. One can see now that 2D
drawing commands become accessible. We will further use these
commands for creating auxiliary elements in the 3D window.

What auxiliary elements do we need? The first body to be created is
a body of revolution. To create it, we will need the contour and the axis of
rotation for this contour.

Drawing in 3D window can be performed using any of the
tools available for 2D drawing. Thus, one can use the sketching
environment for rapid creation of non-parametric models.
Accordingly, parametric modeling approach requires creation of
construction lines first, then application of graphic lines. The
system automatically creates 3D profiles based on drawn graphic
lines, to be later used in 3D operations.

To start drawing, call the command, Icon Ribbon

lcon Ribbon

V4 Draw — Construct — Line
Keyboard Textual Menu

<l> Construct > Line

After activating the workplane by any 2D drawing command, the
main toolbar i1s switched to the mode “Workplane”. In this mode a set of

icons for working on the active workplane is displayed on the toolbar.




For convenience, the active workplane is reoriented parallel to the
screen. However, it can be spun in any desired way, after setting the option

B3

It is also possible to open the 2D window and continue drawing in
2D mode. Once the 2D window is closed, all changes will be reflected on

the 3D scene. The 2D window can be opened or closed using the icon.
Let’s construct two base lines, a vertical and a horizontal one. To do

s0, push the following button in the automenu:

i <X> Create two crossing Lines and Node

Point cursor at the center of the workplane and click .

|

Thus, we have created two orthogonal lines and a node. These will be
used as a reference for all further construction. Press to quit the last active
command. We are now in the parallel line creation mode. (This mode is set
by default in the command “L: Construct Line”).

Just like in 2D drawing, we first need to create a framework
of thin lines, and then apply graphic lines along the intended
segments.
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To construct a parallel line, select a reference line first, that will be
used as the “parallel” reference for the new one. Similarly to 2D operation,
the 3D drawing mode also supports object snapping. Thus, to select a line,
move the cursor to the vertical line. The cursor will gain a glyph like this,

% Click ¥ and move the cursor leftwards. One can see the cursor
changing appearance again — it is now rubberbanding a line parallel to the
selected.

To fix the line at an arbitrary location, just click w) However, we
would like to specify the distance of 100 mm, by typing it in the property
window. (In future, this parameter value can be changed at any time as
desired.) Press <Enter> to complete the line creation.

Line Parameters R X

V| Distance: 100 =

We have just created a line parallel to the selected, at the distance of
100 mm from it. As one can see, rubberbanding resumes at this point. The
system is still in the mode of parallel line creation with respect to the
original selection. Type a new value of 20 mm right away, followed by
<Enter>, thus creating another line. That’s all with the parallel line

creation for now. Click ) or <Esc> key for quitting the parallel line
creation mode.

Next, create four more lines in the similar way, parallel to the
horizontal base line. Use the distances equal to 20, 40, 60 and 100 mm
respectively. The result should look like shown on the following diagram.
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Now, apply graphic lines along the construction lines appropriately.
Call the graphic line creation command:

lcon Ribbon

|£| Draw — Draw — Graphic Line
Keyboard Textual Menu

<G> Draw > Graphic Line

Graphic lines snap to the construction entities — lines, circles, nodes,
etc., as well as to construction line intersections. In the latter case, a 2D
node is automatically created at intersections snapped to by graphic lines.
Straight graphic line segments maintain snapping at their end points. To
have an end of a graphic line snapped to some entity, move the cursor to
the intended location. Let the cursor snap as indicated by an appropriate

glyph, and click w)
In this example, we use snapping to construction line intersections
and to 2D nodes. Draw the profile as shown on the following diagram. To

do so, click with Y at the appropriate points in the order marked on the
diagram.
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To quit continuous line creation mode, click B Note that the graphic
line creation command is still active.

Change the line type in order to draw the axis. To do so, pick the

icon = on the system toolbar and select CENTER type from the pull-
down list.

@ Bl — - CONTINUOUS «| —FI=} & Defaur 2

- v -

;Thm
iConunuous
‘ Center % - = =

[Hddel e e

Draw the centerline as shown on the following diagram.
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2.3. Creating Rotation Operation
One need not quit drawing explicitly in order to create a body of

revolution. Simply call the “Rotation” command as follows:

lcon Ribbon

“» 3D Model — Create — Rotation
Keyboard Textual Menu
<3RO> Operation > Rotation

The system automatically determines the rotation axis and the
contour among the created lines to be used as a 3D profile. You can
preview the result as a wireframe model. In our case, the rotation angle is
360 degrees. Note that the value of 360 degrees for the rotation angle is set
by default in the property window.

Just confirm the operation by pushing the check button (¥, and the
body of revolution is created.

'Rotation Parameters % X

-~

o S T e e T

Angle: gjﬂ
Start Angle: 0
" ¥ Thin Wall

“r 4

2.4. Creating Holes

Next, we need to cut six holes in the part.

Holes can be created by different methods. The fastest and simplest
one is using the dedicated “Hole” operation. The latter allows creating
holes of standard shapes in solids, using templates provided in the T-FLEX
CAD utility library. In this way, the user only needs to specify the position
of the would-be hole within the solid and specify its type and dimensions.
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Non-standard holes and slots can also be created without using the
dedicated operation. To do this, the user should create an additional solid
representing the internal volume of the hole, and then “subtract” it from
the main body’s volume by a Boolean operation.

Let us consider both techniques.

2.5. Creating Holes Using a Dedicated Command

First of all, we will create 3D nodes corresponding to the centers of
the would-be holes, on one of the part’s faces. To create them, we will
again use the 2D drawing mode for creating auxiliary 2D nodes on the
respective face of the part.

To select a face, move the cursor to the desired element of the model

so that it pre-highlights. At this point, press ) to invoke the context menu
and select “Draw On Face” item in it (see the diagram).

Create ’
# Draw On Face

Paste

Information...

Measure..,

Enlarge

% Rotateto

! Parameters...

3 Edit Operation

If the desired element is not getting pre-highlighted, make
sure the selector is set up for this element type. To change
selector’s settings, you can use selector filter icons on the system

panel or select a combination of types from the list.
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The “Draw On Face” command creates a new workplane based on
the selected flat face. The selected face is automatically projected on this
plane, and the mode of drawing in the 3D window activates. Further
construction can use snapping to elements of the face projection.

Projection Grapluc Lmes

<

Workplane borders

Call the command “L: Construct Line” again. Select the following
option in the automenu,

! <V> Create vertical Line

Move the pointer to the center of the circle - the circle center will be

pre-highlighted. It is available for snapping to the vertical line. Click =,
The constructed line will be snapped to the 2D node which was
automatically created at the circle's center.
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Call the command:

lcon Ribbon

9] Draw — Construct — Circle
Keyboard Textual Menu

<C> Construct > Circle

Point the cursor at the center node to select it as the center of the new
circle. Specify the radius of the circle equal to 80 mm by typing in the
property window.

Create a 2D node at the intersection of the vertical line and the new
circle using the command:

lcon Ribbon

Draw — Construct — Node
Keyboard Textual Menu

<N> Construct > Node

17
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MNode on Element "Graphic Line 0x300002C"

Now, one can construct a 3D node based on the created 2D node. To
do this, without leaving the drawing on face mode, call the command:

lcon Ribbon
=, Draw — Construct — 3D Node
Keyboard Textual Menu
<3N> Construct > 3D Node

When the 3D node creation command starts, move the pointer to the

created 2D node and click =) The 2D node will be highlighted, and the

option ¥ will become accessible in the automenu. Click [, and the 3D
node will be created. It will be located in the plane of the selected face,
while the 2D node will be its projection on that face.

The created 3D node will define the center of one of the six holes.
There are two ways to define centers of other holes:

1. Construct five more 2D nodes on the same workplane and create
the required 3D nodes based on the 2D ones (similar to the first 3D node
creation);
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2. Create the required 3D nodes by means of a 3D array based on the

first 3D node.
The second method is faster, so we will use it in this case. Call the

command 3AR: Create Circular Array:

lcon Ribbon

3D Model — Create — Circular array
Keyboard Textual Menu
<3AR> Operation > Circular array

You do not have to explicitly finish the draw on face mode - it
will terminate automatically upon launching the 3D array creation

command.

In the command's properties window, set the array type as “Array of

Construction”. Then, in the 3D window, move the pointer to the created

3D node (the latter shall highlight) and click ™ to select it. If all was done
right, the name of the 3D node selected for copying shall appear in the
properties window.

Array Parameters X
v Common A
~ Rotation (Rows)

Number of copies and total angle v
Number: & v o
Step: ] =

Angle: 380 = (] v
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After that, you need to specify the rotation axis of this circular array.
To do this, you can use a pair of 3D nodes automatically created when
defining the axis for the rotation operation. Select these two 3D nodes one

by one.

Next, let's specify what array parameters will be used (“Number of
copies and total angle”), in the “Rotation (Rows)” section of the
properties window, and enter the required values of the parameters (the
number of copies — 6, the total angle — 3600).

To complete creation of this circular array of 3D nodes, simply click

)

Selecting 3D
node to Copy

Selecting first 3D
node of the
array's axis of

rotation

Selecting second
3D node of the
array's axis of

rotation

Result of
creating an array
of 3D nodes

After creating the array of 3D nodes, you can call the command 3H:

Create Hole:
lcon Ribbon
) 3D Model — Modify — Hole
Keyboard Textual Menu
<3H> Operation >Hole

20




Upon entering the command, you need to activate the option:

[£]8]+]
ooo
[£]8]+]

<M= Add Hole Array

After that, move the pointer to one of the 3D nodes of the circular

array and click Y. In the command's properties window, select the hole
type — “Hole for fasteners”. The preview image of the holes being created
will appear in the 3D window.

‘Properties 3 x
- E ~
R T .. >

2 Hole for check-screws (shape 3, A

(L% Hole for fasteners

i3 Oblong hole for fasteners
f1Square hole for fasteners
k"

Thceadad .

[ ] Hide Connectors
| |Retan material

Hole forfastenen

ot -
Vooa

= i
_- :
=

A\
RN
&i i\,i 7

e

P10 v

| Consder nonplaner (aces

L | Tum over
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At the bottom of the properties window there is a pane with a
schematic image of the hole of the selected type and fields for entering the
hole parameters. Set the hole diameter to be 20 mm.

The following option will be automatically activated in the
command's automenu for the holes of this type:

<F=> Through all

When this option is set, the depth of the holes will be defined
automatically by the part's thickness.

To complete creation of holes, simply click in the properties

window or in the command's automenu.

2.6. Creating Holes without Using a Special Command

In this approach, initial constructions of the holes creation will be
same as in the previous method.

You select a part's face and call the context menu command «Draw
On Face». Call the command “L: Construct Line”. Select the automenu

option . Construct a vertical line passing through the center of the circle

(of the face's projection). Then, call the command “C: Construct Circle”.
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Create the circle with the radius equal to 80 and the center at the central
node. Similarly, create another circle with the radius equal to 10 mm at the
intersection of the previous circle's circumferential and the vertical line.

Then draw graphic line over the newly created circle. To do so, call
the graphic line creation command:

lcon Ribbon

Draw — Draw — Graphic Line
Keyboard Textual Menu

<G> Draw > Graphic Line

Pick the [=1 icon on the system toolbar, and select CONTINUOUS
type from the pull-down list.
Move the cursor to the just drawn circle. The circle will get

highlighted, and the cursor gain a circle glyph. Once so, click 5, that
applies graphics over the whole circle. On a crowded drawing with
multiple elements near the cursor, snapping may occur to an unintended
element.

In such cases, the circle can be explicitly selected by typing <C>
key. This will select the circle nearest to the cursor.
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Two possible approaches are available for further construction. In
one of them, you could draw five more circles, to extrude and subtract
them all from the body of the part. Alternatively, extrude just a single
circle, and then “replicate” the resulting hole by means of the circular 3D
array.

The first approach by steps:

A handy tool for creating the required number of copies of the circle

is the “Create Circular Array” command:

lcon Ribbon
Draw — Additional — Circular array
Keyboard Textual Menu
<XR> Operation > Array > Circular

Once in the command, the system waits for selection of a graphic
entity. Move the cursor to the image of the hole and click to select the
graphic line. That’s all to be selected, therefore, press in the automenu.

Properties aXx

Circular Array V| E=

Mode:
Number of copies and Step v

Copies: (3

i<r 4

Step: 60

i

Total Angle: 350
Center:
[]x%: | 43.934733 [ |y: 60.08
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Now the system expects selection of the array center, which must be
a 2D node. Note that the default setting for the number of copies of the
circular array is 4, and we need six. Therefore, specify the correct
parameters in the property window, as shown on the diagram at right.

Now you can select the node. Move the cursor to the center node and

click . The result will look as on the following diagram.

Next, we will need to call the profile extruding command,

lcon Ribbon
@ 3D Model — Create — Extrusion
Keyboard Textual Menu
<3X > Operation > Extrusion

The system automatically makes a 3D profile from the drawn lines
and sets the extrusion vector normal to the profile.

The amount of extruding, that is, the depth of the hole, can be
defined in various ways (by a numerical value, by the length of the
direction vector, etc.). In this particular case, we need to get a through
hole, that is the one penetrating the entire width of the part.
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In the properties window, set the “First direction” parameter to the
value “Through all”, by selecting from the drop-down list. In this
definition, the extrusion amount is determined by the thickness of the
auxiliary bounding body. Additionally, the created extrusion is
automatically subtracted from that body. This method of specifying the
extrusion distance was devised specifically for quick creation of through
holes in various bodies.

2 General Parameters

First Direcbon
Through Al v

»

4

Leng

21|
=| i«

A=
-

Second Direction

Length: . .

The option of creating a Boolean operation will automatically
activate in the automenu:

s <Ctrl> <B> | Subtraction

Since only one body is present in the scene at the time of creating the
extrusion, it will be automatically selected as the bounding body and the
first operand of the Boolean subtraction.

v

, two operations will be created at once — an

Upon clicking
extrusion and a Boolean operation.
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3D Model ax
2| Detail 1.gb

1) Materials : 1

# 1) 3D Construction

# ) Operations

# I Geometric entties

+ Body_1

i+ Rotstion 1

#] B‘_;@ Extrusion 1

The second approach by steps:

Call the profile extruding command @| Specify extrusion length parameter
equal to 20 in the reverse direction, and confirm the extrusion operation.

Next, let’s call the circular array creation command,

lcon - Ribbon

L 3D Model — Create — Circular array
Keyboard Textual Menu
<3AR> Operation > Circular array

In the command's properties window, select the array type — “Array
of Faces”.

The following option will be automatically activated in the
automenu:

@ <N> Select Faces to Copy or their boundary Edges or Loops
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Aim the pointer at the cylindrical face of the hole and click w)

'Array Parameters 2 x
v @ »
= Common ~
@Extrus:on_l || -
...
< > |

If edges or loops highlight instead of the face, then you can do any of
the following:

— rest the pointer over the face untilthe multiple selection widget "=
appears next to it. Then scroll through the list of elements offered for
selection by rotating the mouse wheel until you get the desired face;

f;ﬂ‘ 8 Select Faces to Copy or thei,
:,j"‘ l Edge
of| [Gl] Face
@l Loop

,
2 =V
> “\! Smooth edge chain selection

| 16| Operation
' 4
-

— before selecting the face, set up the list of 3D objects available for
selection (banning from selection anything but faces). To do this, double-

click & the icon of the faces filter 1. The list of selectable objects can be
also set up by the drop-down menu of the option i} point at the option,

depress ¥ and hold the mouse button for a second. In the appearing menu,

disable all flags except “Faces”.
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Number of copies and totalangle Vv
Number:' 6 = Tk
Step: 20 =
Angle: | 350 : []
[ | Paralle! offset

[ ]|Reverse direction

vmmmeatnr

>y

P Sk 3 -
LODies. 1 -

Once the intended operation is selected, the system expects input of
the axis of revolution for the array. The axis can be assign by the same two
3D nodes as those used in the first method of creating holes. Select these
two 3D nodes one by one.

You can define the array parameters in the properties window —
number of copies and total angle.

Press the I button in the automenu to complete the operation. As a
result, five new faces will be “embedded” in the original body, making up

the additional holes.
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2.7. Creating a Blend

The next step is finalizing 3D model creation. This includes creation

of a chamfer and a rounding. Call the command:

lcon Ribbon

5% 3D Model — Create — Blend — Edge
Keyboard Textual Menu
<3DE> Operation > Blend >Edge

Pick the following option in the automenu:

&l

<E>

Select Edge

The system is waiting for an edge selection. Select two edges in the

order shown on the following diagram.

Next, specify the operation parameters. Each edge can be assigned its
specific set of parameters in the property window by unchecking the

“Common Properties” option.
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| Common Properties Delete [ Common Properses Delete

Radus: 2 S X Offset I 2 e
Offsst |
[ Istart 0 - Offsat 2: 1 -
[ 1End 0 S | IReverse
[ |Propagate |_Propagate
| Appty Convex Bend Frst || Apply Convex Slend First 7t

-

Select the first edge in the list and specify the blending type as
Rounding with Radius equal to 2 mm. For the second edge, define the
blending type as Chamfer (Offsets), with Offsetl and Offset 2 both equal

to 5 mm. Confirm the operation by pressing . The result appears as
shown on the following diagram.

This completes creation of the given 3D model.
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3. THE ORDER OF LAB WORK

1. Come to know the principles and steps of the modeling process.

2. Get acquainted with the basic commands in creating three-
dimensional models of geometric objects.

3. Create three-dimensional model (elementary three-dimensional
figure with a hole) according to the individual tasks (Table 1, 2).

4. Conclude lab work.

5. Complete a report.

4. REPORT STRUCTURE

1. Theme and purpose of lab work.

2. Brief theoretical information.

3. Three-dimensional model of the part.
4. Conclusion.

5. Answer the questions from the checkilist.
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1.

5. CHECKLIST

The possibilities of 3D modeling technology in the design of

machine parts.

o 0k W N

7.

What are the advantages of 3D modeling?

Main approach to 3D model creation.

What is the basis of 3D modeling?

The principles and steps of the modeling process.
The sequence of creating a 3D model of the part.

What are the basic commands in creating three-dimensional

models of geometric objects?

8.

Classification of three-dimensional models by functional purpose

and their difference.

Q.

The functions of the dashboard, toggle bar and work bar of the 3D

modeling program.

10. Creating auxiliary elements in 3D modeling.

11. Creating rotation operation by means 3D modeling.

12. Creating holes of the part by means 3D modeling.

13. Creating holes in the 3D modeling program using a dedicated

command.

14. Creating holes in the 3D modeling program without using a

special command.

15. Creating a blend of the part by means 3D modeling.

16. How to specify the operation parameters in the 3D modeling

program?

33



Task 1
for lab work Ne 4

Create three-dimensional model (elementary three-dimensional

figure with a hole).
Table 1

OA 1A ViewA
L0 [9s] pA 0 16% =
Zaqll
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Task 2
Create three-dimensional model of the part.

Table 2
vJ:_; Drawing of the part and its dimensions
1 2
1
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Continue Table 2
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Continue Table 2
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